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Micro Focus Enterprise Server 2.3 Update 1
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

/ Note:

» This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.

Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

» Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Server provides the execution environment for applications created with any IDE variant of
Enterprise Developer.
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What's New

This release provides enhancements in the following areas:

« Application Server JCA support for Enterprise Server

» Enterprise Server

» Data File Tools

« Database Access - HCO for SQL Server

« Database Access - OpenESQL

* File Handling

« iFileshare - Fileshare under Enterprise Server (Early Adopter Product)
e PL/I support

Application Server JCA support for Enterprise Server
Back to Top
This release provides support for:

< Automatic connection recovery to an active Java application server when an enterprise server region is
restarted. This applies to:

« COBOL resource adapters
» CICS resource adapters
e All CICS API based programs
e The IBM implementation of CICS resource adapter for WebSphere 8.5 and JBoss 7.1.1.

Data File Tools
Back to Top
This release provides improved security and increased support for more file types. Features include:

« Certain aspects of Enterprise Server security are honored when you attempt to access data sets. If the
Enterprise Server region has security enabled, logon details must be authenticated before you can
access the data set. If the details are unable to be authenticated, access is denied.

« When using a record layout, certain data is now validated at field level (to ensure the contents is
compatible with its picture string ) and record level (to ensure the record length matches the layout
size).

« Full editing support has been added for variable block sequential files and relative files. Full editing is
also available for line sequential files, as long as they do not contain any binary data.

Database Access - HCO for SQL Server
Back to Top
This release provides the following new features:

< End-to-end demonstrations that show several methods for submitting a JCL batch job that calls COBOL
stored procedures. To view these demos, see the SQL demonstrations in the Mainframe Samples
browser.

e The SPCALLLOCAL SQL compiler directive option, used to convert an EXEC SQL CALL into a call to a
local COBOL subroutine instead of a call to a SQL Server SQLCLR stored procedure.

» Extended support for conversion of the DB2 CONCAT function.

What's New
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Database Access - OpenESQL
Back to Top
This release provides the following new features:

» Support for the Oracle fully managed ODP.NET driver.

Enterprise Server
Back to Top

This release provides support for the SO_RCVTIMEO and SO_SNDTIMEO timeout options of EZASOKET
support that help reduce the risk of applications becoming unresponsive due to EZASOKET APIs not
completing.

File Handling
Back to Top
The following enhancements have been made to file handling processes:

* A new indexed file format, IDXFORMAT12, has been introduced to improve file maintenance and
recovery procedures when using the rebuild utility. This file format is similar in structure and use to
IDXFORMATS8. Where the two formats differ is that an IDXFORMAT12 file has an accompanying side
file (. 1dx file) containing the indexed key information.

You can use this type of file with the new rebuild /q option. This rebuild process is considerably
quicker than other rebuild processes such as a data scrape or rebuild /p.

» Faster SORT operations for fixed block records - when using the DFSORT emulation, the performance
when sorting fixed block records has greatly improved.

iFileshare - Fileshare support under Enterprise Server (Early Adopter Product)
Back to Top

v+, Attention: This feature is in Early Adopter Product (EAP) release status. We intend to provide the
= finalized feature in a future release. Please contact Micro Focus SupportLine if you require further
clarification.

You can configure iFileshare to offer enhanced availability for mission critical files by configuring a high
availability group, consisting of a primary iFileshare server and a number of stand-by servers.

Files that are critical to your application can be replicated from a primary server onto the stand-by servers.
Should the primary server fail, you have up-to-date data (minus any in-flight transactions) available.

If Enterprise Server work is being hosted on the primary region within the group, the setup must be
consistent on all standby Fileshare hosting regions so that work can continue in the event of a failover.

Mainframe support and emulation
Back to Top
This release provides the following enhancements:

e Support for using multiple catalog files (up to 32).
« Support for storing the spool files in a location that differs from the location of the catalog file.
« Enhanced support for searching the catalog using wildcards.

PL/I support
Back to Top

Support is available for the following features:
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» FIXED BIN(63) data type - PL/I programs that utilize FIXED BIN data types that are larger than FIXED
BIN(31) are now supported which enables you to migrate such programs more easily to distributed
platforms.

e TRIM() built-in functions - the Open PL/I macro preprocessor how supports the TRIM() built-in function.

* A 64-bit Open PL/I peephole optimizer - when compiling 64-bit Open PL/I programs optimization for
speed, a peephole optimizer is now run against the intermediate code to improve your applications'
performance. Any code which has attributes that benefit from peephole optimizations will then run
faster.

What's New | 7



Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

» Communications Server

» Enterprise Server

« IBM Language Environment for OS/390 & VM Support

e JCL Support

e Run-Time System

* SQL: OpenESQL

¢ SQL Option for DB2

Communications Server
Back to the list

e A new option, [Operation] synchronous=yes (or 1, or Yes, ory or Y) is now supported in the
Fileshare listener configuration.

Enterprise Server
Back to the list

» In situations where the crossregion option of the shareoptions parameter is either 1 or 2, both a CICS
and a JCL job could have the same file open for 0. This has been fixed. In addition, the -00' (and the
synonymous '-0 ') option of the casfile command has been deprecated. If '-00' is used, you will now
receive a return code 4 (warning). Instead of '-00', you need to use the "-ooi' option (open immediate). If
-00 is used with a region configured for VSAM shareoption use, the '-00i' option is now forced.

2839272 (1101672)

« When using an external security manager to secure a region, the EXEC CICS START TRANSID API
now works as expected and honors the USERID option. Previously, the started transaction would run
under the authority of the user that executed the EXEC CICS START API.

2835112 (1101201)

IBM Language Environment for OS/390 & VM Support
Back to the list

*  When calling SETENV, SYSOUT(?) can be specified. This designates the file as a spool file but will not
update its CLASS.

2841220 (1101955)

JCL Support
Back to the list

e The return code from a JCL printer exit will now be checked. If it is non-zero, the dataset that was sent
to the printer exit will be moved to the OUT-HOLD queue rather than to the PRINTED queue. To release
the dataset, click "Release" in the ESMAC view - this will also present the dataset again to the printer
exit.
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2834206 (1101079)

« Under Enterprise Server, flushing an active job previously resulted in all associated spool records for
the job being deleted, but left the job running. A subsequent attempt to kill the running job using casout/
seeout failed due to the job spool record no longer existing. This change causes the flush request to fail
if the job is active. You must kill the active job first before attempting to flush it.

« The catalog search facility has been enhanced to provide a quicker return when using wildcards in the
dataset name selection.

2698700 (1094266)
« REXX can now be executed in VSE via IKJEFTO1 and IRXJCL using in-stream data.

2831984 (1100883)

Run-Time System
Back to the list

« The Audit Manager contains a new TIMEOUT option. When a client sends an audit event using the
‘CBL_AUDIT_EVENT' API, the event gets placed in the next available slot in a shared memory block. If
shared memory is full (i.e. no slots are available), the event is re-tried until a slot becomes available.

If no Audit Manager is running, no events are removed from shared memory, and no slots will ever
become available. Therefore, use the new TIMEOUT option so that a client will only retry sending until
the TIMEOUT duration is reached; after which, it will stop sending audit events. If Audit Manager is
recycled, events will start to be sent again.

To set the TIMEOUT for all Audit Manager clients, specify the following line in the Audit Manager
configuration file;

mfaudit.timeout = n

Where n is the timeout value in milliseconds.

To set the TIMEOUT for an individual Audit Manager client, use the
‘CBL_AUDIT_CONFIG_PROPERTY_SET' API. It takes an integer property-value, which should be the
timeout value in milliseconds.

If TIMEOUT is set using both methods, the client property TIMEOUT takes precedence, unless this
property is set to zero; in such cases, the TIMEOUT in the configuration file is used. If you use the
‘CBL_AUDIT_CONFIG_PROPERTY_GET’ API on the ‘TIMEOUT’ property, it only returns the
TIMEOUT value for the client property; it does not return the value set in the configuration file.

2838689 (1101685)

« Several changes have been made to the implementation of IS DBCS, IS KANJI and IS JAPANESE
class condition tests:

- IS [NOT] DBCS

When CHARSET"EBCDIC" is in effect, the IS DBCS test returns true when each character in the
string is deemed to be a valid DBCS character. A valid character has its first byte in the range 0x41
through OxFE, and the second byte in the range 0x41 through OXFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the DBCS test uses an OS call to determine if
the string contains only valid double-byte character, and returns true if valid.

e IS [NOT] KANJI

When CHARSET"EBCDIC" is in effect, the IS KANJI test returns true when each character in the
string is deemed to be a valid Kanji character. A valid character has its first byte in the range 0x41
through Ox7F, and the second byte in the range 0x41 through OXFE, or the character is an EBCDIC
space (0x4040). When CHARSET"ASCII" is in effect, the IS KANJI test uses an OS call to determine
if the string contains only valid Kanji character, and returns true if valid.

« IS [NOT] JAPANESE

When CHARSET"EBCDIC" is in effect, the IS JAPANESE test is not supported, and will generate a
COBCH1806 Feature not supported in selected charset message on compilation.
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When CHARSET"ASCII" is in effect, the IS JAPANESE test returns true when the string contains
only double-byte Japanese characters or single-byte Japanese Katakana characters, and returns
true if valid. When NSYMBOL"NATIONAL" is in effect, these class tests are not supported, and will
generate a COBCHO0303 Operand has wrong data-type message on compilation.

2812895 (1098401)

SQL: OpenESQL
Back to the list

« The DB2 CONCAT function and operator now convert to SQL Server using the HCOSS-supplied
dbo.CONCAT for character, numeric and datetime data. If you are using BINARY or VARBINARY data,
you must apply the HCOSS-supplied dbo.CONCAT_BINARY function. HCOSS applications deployed
with earlier versions of Enterprise Developer are affected, if they use string or binary concatenation. The
mainframe dialect DB2 || operator and CONCAT function now call a new SQL Server scalar function
dbo.CONCAT(). All existing programs with dialect=mainframe that use DB2 concatenation syntax should
be recompiled. All existing SQL Server databases that are accessed by these programs must have
dbo.CONCAT installed. To create the new function in your application’s SQL Server database, you can
either:

¢ Run a DSN bind against the customer database. Or:
« Execute the %ALLUSERSPROFILE%\Micro Focus\Enterprise Developer\hcoss
\InstallDigitsFunction.sql script.

This is a one-time only change to the database.
2843818 (1102248)

SQL Option for DB2
Back to the list

* Spurious errors were sometimes returned while querying using an ALIAS.
2830383 (1100609)
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Known Issues

Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Enterprise Server

The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to O.

In Enterprise Developer 2.3, some job scheduling tools from third-party vendors might stop
communicating with Enterprise Server. This might have an impact on our external partners who
integrate with Enterprise Server such as job schedulers which do not use MFBSI. The issue might occur
with job schedulers such as Zena, CA, ASG or UC4, if these are run outside of a COBOL environment
with the path set. Click here for more information about the issue and how to work around it.

Linking

Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C
object code built with that version of Visual Studio in the same executable. In this scenario, you must
use the Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro
Focus cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might
also need to specify some additional C runtime libraries - see the Microsoft documentation for more
details.

Note that when using COBOL and C object code together, Micro Focus recommends you build and
keep the COBOL and C executables separate, and use import libraries and the Micro Focus C functions
for calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between
them.

PL/I Support

The Micro Focus PL/I Macro Preprocessor supports the majority of the IBM PP(MACRO) functions. The
only support for PP(PLX) is for the deprecated KEYS option. There are no plans to further extend the
existing support for PLX.

On SUSE, the PL/I CodeWatch debugger does not display output with MicroFocus ViewNowX. To
resolve this issue, you need to install a HotFix of ViewNowX - contact Micro Focus SupportLine for more
details.

Trying to debug remote PL/I projects that compile to 32-bit using the CodeWatch debugger fails. To work
around this issue, you must set the environment variable $COBMODE to COBMODE=32 on the remote
machine before you start the RDO daemon.

Resource Adapters

Trying to deploy the local resource adaptor mFcobol-localtx. rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa. rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx. rar. If there are issues deploying

Known Issues
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using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).
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Resolved Issues

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

« Adis

* Assembler Support

» CICS BMS Compiler

e CICS Support

e Common Communications Interface
e Communications Server

« Documentation

« Enterprise Server

* File Handling

e IBM Language Environment for OS/390 & VM Support
¢ IMS Support

* Interface Mapping Toolkit

e JCL Support

e Mainframe Access

« MFIO

e Micro Focus Common Client
* Micro Focus Directory Server
« Monitoring and Management
e PL/I Support

* Run-Time System

e SQL: COBSQL

e SQL: HCO for DB2 LUW

¢ SQL: HCO for SQL Server

e SQL: OpenESQL

e SQL Option for DB2

e XML Support

Adis
Back to the list

» Deleting a DBCS character no longer causes corruption when the ADISCF options 15 Pre Clear and 29
Read Screen are specified.

2848637 (1102857)

Assembler Support
Back to the list

e The DCB macro requires the DSORG= parameter in order to be more compatible with the mainframe.
This parameter has now been added to the Assembler sample programs PGASMO04.mic and
gsamex4.mic in the Mainframe\Assembler\Classic\QSAM directory in the installation location of the
samples so that these files now assemble without any errors.

CICS BMS Compiler

Back to the list
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A new menu item, Customize IDE, on the Options menu of the BMS Painter utility enables you to
specify your preferences for a font face and font size of the text within the BMS Screen Painter and in
the Output window.

2835960 (1101266)

CICS Support
Back to the list

14 | Resolved Issues

Some issues in COBOL Web services and CICS COMMAREA-based web service environments when
EXCI was involved have been fixed. Previously, an ADPL abend was issued when a CICS program
executed an EXEC CICS SYNCPOINT in a CICS COMMAREA-based web service environment. This
has been fixed.

2848968 (1103075)

When using ISC, ADPL could abend and the client terminated the transaction after changes introduced
by CWS work for LINK without SYNCONRETURN. Enterprise Server now allows the commit to take
place when it receives the end of a conversation and when dfhzcsmi is issuing the commit.

2848069 (617536)

When ES_XA RECONNECT is set to true and a number of retries is defined for

ES_XA nnnn_NB_RETRIES (where nnnn is the XAID), the number of retries was not being checked,
and the XA switch was disabled immediately after a connection issue occurred. The value defined in
ES_XA nnnn_NB_RETRIES is now honored and, when a connection issue occurs, the switch is not
disabled until after the connection has been attempted for the number of retries.

2843692 (1102209)

Previously, the product did not identify PL/l programs as such and defaulted to ASCII. PL/l program are
now correctly identified as such and use the API-CODESET value that has been set by PL/I in the
CICS-API control block.

2841424 (1102109)
An ENQ taken for a write-lock when writing to a recoverable TQD was not released at the end of a task.

2849271 (1102960)

When you start a region, there is no longer a delay of one second per printer when the printers are
installed.

2847778 (1102784)

CASPRT now calls the casmguex exit so that the CASCL0020l message can be suppressed from the
console.log file.

2847778 (1102785)

A problem in the dfhgglbl module when a SPOOL process was active could cause a CICS process
cassplcp to fail to start with a run-time system error 114.

2840334 (1101859)

PL/I applications no longer abend on the second and any subsequent invocations when the "Force
Phase In" setting is set to "off". This occurred on all supported UNIX and Linux platforms.

2834015 (1101058)
Previously, the PROTECT option was not recognized when using START/PROTECT with TRANCLASS.

2832905 (1100929)

When using mirror transactions, if a resource has browse placeholders or is recoverable, or the lock has
been acquired, a mirror transaction becomes a long-running mirror and does not end until the issuing
transaction ends the logical unit of work - on SYNCPOINT or RETURN. Any resources that the mirror
has acquired are freed when the initiating transaction issues the appropriate command to free them.
Previously, mirror transactions were only released on RETURN. They are now also released on
SYNCPOINT.



2829652 (1100859)
When installing a terminal that was not in use, an incorrect flag was checked. An error message
"CASRDO0O025E 3270 Terminal entry xxxx is out of service or it is in use" was displayed.

2821671 (1099558)

Previously, when using TRANCLASS, if a TSQ was deleted in one thread while another thread was
trying to read the queue at the same time, Enterprise Server returned an ITEMERR error instead of
QIDERR because the queue had been deleted.

2819309 (1099471)

A problem adding a new startup group on the casrdo97 startup list ESMAC page immediately after
deleting a group on the same page has now been corrected.

2850524 (1103106)
When sending a response back, the product now escapes any HTML sensitive characters in order to
avoid an XSS scripting vulnerability.

2846631 (1102678)

The behavior of non-facility transactions was too silent. Messages are now being sent to the console
about transaction attach failures. The message KC0041 is now sent to the console for asra abends.

2845530 (1102445)

Performing a phasein on an active program could corrupt the local storage chain for the SEP which was
running that program. A Run-Time System error could occur.

2846132 (1102972)
The casfile -00i option failed with an RTS114 error when opening a CICS FCT of the Alt Index type.

2845760 (1102598)

Common Communications Interface

Back to the list

The performance of Fileshare servers on Linux and UNIX platforms has been substantially improved
since the 2.2 Update 2 and 2.3 releases of Visual COBOL and Enterprise Developer.

2829622 (1101067)

On UNIX, the product previously was looking for the cciusers.dat file (used for the initial population of
the MFDS Internal Security users and groups) in the /etc/ folder. Starting with this release, the
cciusers.dat file in $COBDIR/etc/ is used in preference. This removes the requirement to store
cciusers.dat in the /etc directory.

Components that use the SSL/TLS support in CCl, such as Fileshare and MFDASMX, can now use
private key files in binary (DER) format.

Communications Server

Back to the list

The Enterprise Server EZ Sockets feature no longer fails to initialize at system startup if the MFCS
connection to MFDS is unusually delayed.

2847439 (1102743)

Documentation

Back to the list

The documentation has been updated to include the "ra.xml file" topic describing the contents of the
ra.xml file, which includes a list of properties that configure your CICS resource adapter.

2828775 (1101075)
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* The topic "DEFINE CLUSTER" in the product help has updated information about the RECORDSIZE
parameter and the file that will be created.

2830878 (1100668)

* The instructions in the product help on how to run .NET COBOL applications from a network server
have been updated. These now include details about how to make the appropriate .NET run-time
assemblies available to your applications and how to elevate the security permissions levels of the
applications.

2826751 (1100478)
*  When handling XML files, after a successful WRITE action, the size of the XML file written is returned
as the status code.

2587541 (1085484)

« When using Fileshare with the CCISM protocol, ensure the server is started using the /SC switch. This
switch starts Fileshare in synchronous communications mode, which gives better performance than
when using Fileshare with the CCITCP protocol. Without this switch, Fileshare operations may be
slower.

* An Enterprise Server error message has been added to the help pages for CASKC0048, process soft-
killed failed and was hard-killed.

2846350 (1102574)
* The Idpli topics have been updated to include information about native Id options.

2840325 (1101829)
* The product help now provides the correct definition of the ES_ESM_RESSEC environment variable.

2836105 (1101281)
« libmf.so has been renamed to libmfpli.so/libomfpliz.so in the Open PL/I User's Guide.

2822746 (1099744)
* The "mfsupport” utility is now correctly named and spelled as MFSupportinfo, for Windows platforms.

2848869 (1102896)

* In the topic "Sample Parameters File", the value of Keys towards the end of the code sample has been
changed from 48 to 60.

2844479 (1102300)
e The parameter TSOE_JOBPREFIX has been replaced with TSOE_JOBCHAR.

2844210 (1102719)

< Additional information added to the help pages for the audit event codes emitted by the External
Security Facility (ESF) and Micro Focus Directory Server (MFDS).

2842807 (1102120)

« If you receive a 9/064 file status, this is informing you that a process has attempted to open a file using
a different locking mode than the one that is already in place. The locking mode is determined by the
tunable strict_file_locking. All processes accessing the same file need to be using the same locking
mode; that is, all have the tunable set to the same value, which can be either 'true’ or ‘false’.

2837405 (1101440)

* The product documentation has been updated to include the topic "IMS and GSAM Databases" located
in the table of contents under Programming > IMS Support.

2789025 (608922)

» Option D(0) in the Character Animator is only applicable when you are debugging intermediate (.int)
code.

2839572 (1101835)
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Enterprise Server

Back to the list

The caslock utility now validates the APPLID. In order for caslock to remove all locks for a given cluster
client, the passed APPLID must already be known to the GLM - for example, it must already have an
entry in the CASGLM.LCK file.

2847684 (1103145)

Cancelling a job sends a sigterm signal indicating that the process needs to terminate. If the process
did not complete, Enterprise Server would then send a sigterm again instead of sending a sigkill signal.
A sigkill signal is now correctly sent in such situations.

2845534 (1103261)

When processing a WSBIND that contain nested occurs levels, the group level is now correctly
maintained.

2844738 (1102697)
XA transactions will now end when an ECI request fails with PGMIDERR.

2843668 (1102276)

The order in which user privileges are checked when accessing cataloged files has changed. First, a
check for the alter privilege is performed. If access is denied, Enterprise Server performs a check for
update privileges. If this check fails as well, a final check for read access is performed. This is reflected
in both the console log output and in any Audit Manager events that are generated.

2842162 (1102048)

Previously, when generating a MQRFH2 header, the CCSID that was used was 0. This resulted in an
abend APIJ on the CPIL transaction and in an error 2111 on the MQGET API. The MQRFH2 header is
now generated with the correct CCSID values.

2841974 (1102004)

When the targetService option was enabled for the JMS Invoke Webservice, no response was returned
to the application if the URIMAP was not found. This caused the transaction to hang. A message is now
sent to the Dead Letter Queue, and the application fails with an error message DFHPI10112.

2841602 (1101959)
casspool type 16 records (spool-printed-88) are now being processed and the printed spool records get
deleted when using Delete from the ESMAC page.

2839657 (1101706)

Mainframe Subsystem support for the EZ Sockets APIs in Enterprise Server now includes the
SO_RCVTIMEO and SO_SNDTIMEO socket options. Support for these is limited to the options
provided by the underlying Operating System.

2833375 (1101002)
A Run-Time System error 114 no longer occurs when a GET request is received.

2825851 (1100157)

You can now start Enterprise Server instances that have the casuesm exit enabled. If you are already
using this exit, you must recompile your applications using the updated cascbesm.cpy that is in the
cpylib subfolder in the product installation directory. You also need to include the version check at
initialization time that is implemented in the skeleton casuesm.cbl file that is in the src in the product
installation directory.

2821228 (1099658)

You no longer receive a memory leak in cassi processes when using the Micro Focus External Call
Interface.

If no license has been found when starting Enterprise Server, Enterprise Server Administration now
periodically checks whether a license server is present.

2836688 (1101388)

Resolved Issues | 17



18

The Enterprise Server External Security Facility, using LDAP-based security, no longer incorrectly

matches a wildcard character ("*") in a resource access rule to a period (".") in the requested resource
name. The double wildcard sequence ("**") does match a period (".").

2854402 (1103604)

When using LDAP-based security immediately after installing Enterprise Server, with the sample access
rules provided with the product, the TRANCLASS definitions in ESMAC are now granted administrative
access to as it is for other resource types.

2838380 (1101547)
The LISTREFERENCES command now works correctly when the resource class names use special
characters.

When using a JES initiator in the GLM, the locks could not be released properly if a job was running in
that initiator while another process was waiting for the locks.

2838871 (1101612)

File Handling

Back to the list

OPEN EXTEND EXCLUSIVE for sequential files accessed via ACUFH/RMFM now correctly locks the
file.

2849233 (1102953)

If a program opens an RM/COBOL or ACUCOBOL-GT data file, and the file format has been specified
at compile time (and not in a run-time config file), then file assignments containing a sub-path will
correctly search locations specified by COBDATA.

2842825 (1102218)
Rebuild now correctly processes the key structure defined through an options file.

2837028 (1101412)

Relative filenames specified with dot-slash (e.g. ./file.dat) will now match filename tags in the extfh.cfg
configuration file (e.g. [file.dat]).

2832386 (1100932)

Rebuild option /t now supports extended ESDS (XESDS) files. Rebuild also allows you to create an
ESDS file without supplying the index key information (option /K).

2837756 (615857)
Rebuild now allows the case where "9" is specified after ":"

2836782 (1101437)
SEP corruption no longer occurs when running a SORT operation.

2843320 (1102182)
MFSORT now returns a 9/018 error when an incorrect record length is specified.

2834614 (1101131)

Sort operations on 64-bit UNIX platforms no longer produce a COBRT114 error if record size is bigger
than maximum non-key data portion held in memory.

IBM Language Environment for OS/390 & VM Support
Back to the list

Resolved Issues

The Language Environment jobs which are run after an abend now runs correctly.

2847262 (1102897)

A problem with multiple calls to MFLEINIT without subsequent process termination causing exhaustion
of virtual file space has been corrected.



2829308 (1101231)

IMS Support
Back to the list

The IMS database editor could not access a database directly. The editor was only functional when
editing a database using a PCB in a PSB.

2849835 (1103025)
Direct access to a secondary index database that uses system generated /SX fields no longer fails
when the primary database is compiled using the SXRBAFORMAT"2" directive.

2845024 (1102464)
Read only access to an IMS database from a batch application failed after IMS DB had performed an
automatic backward recovery. Restarting the server corrected this condition.

2844983 (1102431)
A BMP program using a PSB that specified CMPAT=NO sometimes returned incorrect results to a DB
call.

2844084 (1102463)
Batch IMS applications that access IMS database data directly can override ES_IMSDAT and access
this data in different folder locations.

2833328 (1100981)

A DBD from a DOS/VS environment that made use of an assumed START= parameter on the SEGM
FIELD statement was previously unsupported. This support requires the IBMPLATFORM=DOSVS
DBDGEN directive.

A protection fault resulted when attempting to load an IMS database using MFDAS when the ACB was
missing.

The Admin SEP no longer abends with an RTS 114 error when starting an MPR with an MPR name.
2845871 (1102500)

The attribute byte for a dynamic attribute was being improperly converted. This has been corrected.

2849654 (1103033)

The limit of labelled DFLDS and MFLDS has been increased from 500 to 1000 per MFS. This enables
you to use MOD 5 type of screens (24 X 132) which can contain many more fields than the more
common MOD 2 type of screens (24 X 80).

2849190 (1102943)

The MFS generator has been updated to fix an issue with /FOR Type-5 screens. To apply this fix, you
must regenerate your MFS source files using this release of the product. Also, the device type specified
in the MFS for MOD 5 screens (27 X 132) must be 3270-A7.

2848896 (1102915)

MFS files with literals of the form "DFLD G'<dbcs characters>',POS=(03,1),LTH=54, ATTR=(PROT)"
were seeing the last byte of the literal clipped in the generated control block and on screen at run time.
This problem has been fixed and all G literals should generate and display correctly.

2848014 (1102773)

If the trancode is 8 bytes in length and the application does not accept a trailing space as part of the
input message, you must ensure that the trailing space flag is checked in the enterprise server
configuration. In addition, a fix has been made to IMS code that applies to conversational application
when the trancode is less than 8 bytes. When the conversation starts for the very first time, IMS now
strips the trancode out of the input message and puts it in the trancode area of the SPA buffer. The input
message is then shifted to the left by the length of the trancode. Afterwards, the input message is
formatted strictly by the MFS input definitions.

2837836 (1101690)
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If the last output LPAGE is missing its COND statement, an error message is considered unnecessary
and is no longer issued. You will still receive an error, if the COND statement is missing from any output
LPAGE that is not the last.

2833816 (1101032)

The NULL FILL value in the input field (pfkey) is now correctly recognized and NULL FILL characters
are stripped out from the input message and the message is compressed. When the field following the
field (pfkey) with NULL fill characters is the trancode field, MFS now invokes the application associated
with the trancode. Katakana characters are not displayed correctly. To work around this issue, you need
to set PCOMM or RUMBA codeset 930 which is compatible with MFCODESET=9122.

2833225 (1100955)

The APARM returned to the AIBTDLI INQY ENVIRON call is now restored with each execution of the
INQY call.

2846411 (1102605)

A previous update had updated the behavior of a CHNG call issued from an OTMA- or IMS Connect-
submitted transaction such that the destination was assumed to be the OTMA client. In some
circumstances, the previous behavior of assuming a non-OMTA client is desirable. To use the previous
behavior, setthe ES_IMS_BYPASS OTMA _DEST_RES Enterprise Server environment variable to
ES_IMS_BYPASS_OTMA_DEST_RES=y.

2835781 (1101595)
For servers using external security, IMS printers sometimes failed to reconnect after disconnecting.

2835352 (1101479)

The IMS Database Utility could not load an IMS database when a special character such as "@", "#" or
"$" was used in the first position of the segment name definition (DBD SEGM NAME-=).

2848521 (1102845)

On Red Hat Linux, incorrect results were returned to an EXECDLI application program. The WHERE
clause of a GET call was incorrectly negated.

2845172 (1102400)

Interface Mapping Toolkit

Back to the list

Ebiz execution no longer fails when tracing is enabled and several programs contain a mismatched
linkage offset.

JSON request messages containing multi-byte UTF8 characters caused errors for REST web services.

JCL Support
Back to the list

20 | Resolved Issues

You no longer receive an RTS 173 error (program not found) when running mvscatpb on Linux UNIX
platforms.

2841338 (1102050)
MFDB2UNL did not process the SELECT statement correctly if it started in a column other than 1.

2845002 (1102407)
An issue that caused SSTM and JCL-enabled regions to hang when starting has been resolved.

2849994 (1103031)

IDCAMS ALTER now supports renaming of physical files if they have an environment variable specified
in their paths. To enable this behavior, you must set the environment variable MF_PCRENAME_LAX to
Y.



2848692 (1102898)

When assigning a new job number, records from past jobs with the same job humber were erroneously
included in the job listing.

2847426 (1102709)

The spool housekeeping utility, mvssplhk, now does not delete active CICS SSTM jobs. It is possible to
remove expired SYSOUT datasets from the jobs.

2847421 (1102708)

It is now possible to include key offset and length information when replacing cataloged VSAM index
and data elements using MVSCATPB.

2846554 (1102608)

MVSSPLHK has been updated so you no longer receive a duplicate error when the CATALOG is
archived.

2846100 (1102623)

Using the MFCATXML or the MVSCATPB REPL function to replace a catalog no longer causes the
enterprise server to hang.

2846018 (1102524)

When loading catalog records from an XML file using MFCATXML, the pds extensions from earlier
records are no longer carried forward.

2845761 (1102519)

Quoted values are now supported for the PRTQUEUE OUTPUT statement.

2844696 (1102356)
Job outputs are now correctly being sent to the printer exit when there is a heavy JES workload.

2844053 (1102254)
The following DATACLAS parameters are now supported: AVREC/AVGREC, DSORG and RECORG.

2842497 (1102064)

A DD referback was incorrectly using the catalog properties of the file referred to and not just those
DCB parameters defined on the referred to DD card.

2842304 (1102044)
The MVSSPLHK housekeeping process now correctly removes JOB99999.

2842083 (1102018)

The Micro Focus emulation of ICETOOLS no longer incorrectly processes the RDW directive twice.
Previously, this would lead to lost data.

2841136 (1101894)
A JESYSMSG for a reprinted job now correctly displays in the JES Spool>Printed queue.

2840462 (1101867)

The change date in the catalog was not being updated for concatenated datasets. The catalog now
shows the time/date for the end of step processing for all concatenated datasets.

2840128 (1101779)

When the first job run uses 2 programs that both open the same file, the Shareoption Manager no
longer incorrectly returns an access denied message.

2839737 (1101834)

Where appropriate, LEX files are now correctly removed during the MVSSPLHK spool housekeeping
process. Previously, if the ES_ALLOC_OVERRIDE variable specified a different location to the
MFALLOC_LOC variable these files could be missed. Also, the message for casspool record type 16
records in SYSPRINT now displays correctly.

2839699 (1101778)
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* A SORT operation on a Variable Block file where INREC processes are specified no longer incorrectly
changes all records to Fixed Block.

2839561 (1101737)
« The correct next bias number for GDGs will be used when existing biases are removed.

2837967 (1102225)
e The casout /g<jobnum> command now works correctly when ES_JESYSMSG_OUTPUT=Y is set.

2837860 (1101512)

« The IDCAMS REPRO command generates a file status 35 if the physical file of a cataloged input file
does not exist.

2837596 (1101509)
« A problem where incorrect HSF stats were being reported for the SSTM job has been corrected.

2837158 (1101448)

 If a printer exit requests removal of the JESYSMSG (JCL Job log), any OUTPUT statement and
SUBSYS information is retained. If restart is enabled, the job log and other job files required for
restarting are not removed.

2836023 (1101573)

*  When copying SYSUT1 to SYSUT2 (using IEBGENER), where SYSUT?2 is a spool file with no RECFM
supplied in the JCL, the SYSUT1 RECFM is now used if it is valid. Previously, it was only being used
when set to "F".

2834419 (1101200)

« Itis now possible to scroll backwards from the first spool display page to the last one. If the spool file is
rather big, however, scrolling could be slow as all the spool records need to be processed before the
last page is displayed. This is the expected behavior.

2833812 (1101030)
* You no longer receive a file locked error when JCL accesses CICS shared files.

2833284 (1101010)
» JCL validation no longer fails an OUTPUT statement that has no parameters.

2833175 (1100991)

e An error in the JCL scanner that reported a JCL error when scanning a job that contained a NULL IF
statement has been corrected.

2832582 (1101015)
e The JCL COND CODE for PRINTED queue records was displayed with invalid characters.

2831180 (1100784)

« A problem that resulted in receiving an RTS 114 error when clicking on the REPLY button has been
fixed. This would happen if you were using dynamic debugging to debug a JCL job and clicked "Stop
Debugging" while the job was still waiting for an input from the user.

2828547 (1100819)

« MVSSPLHK now scans the LEX file directory for orphan LEX files, and deletes them if they are older
than the max retain period.

2826722 (1100693)

* Using DSNRLI with multiple XA switch modules and performing a 'SWITCH-TO' action to a XA resource
with a name shorter than the previous resource, caused an error with a return code of 4 and a reason
code X'00C12205'. The DSNRLI module now correctly performs 'SWITCH-TO' actions.

« Enterprise Developer now provides a new utility, MFJPTPCH, that emulates the IEBPTPCH (Print-
Punch) utility.

* This release provides a new environment variable, MVSSPOOLDIR, which can be used to direct spool
files to a location which is different to the location of the main catalog file.
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2839703 (1101713)
» Itis now possible to configure multiple user catalogs for Enterprise Server.

2514366 (1101309)

* The SETPARM statement can now be used with the IF statement. For example: SETPARM pppp=xxxx
IF pppp=xxxx

2820858 (1099472)

Mainframe Access
Back to the list

* In the shipped MFAAS JCL proc required for the Changeman dependent server, a DD CEEOPTS points
at a member in the Mainframe Access parameter library. Because the CHM support changes the ACEE
task to that of the user, the user must have read access Mainframe Access MFA parameter library. If
this is not acceptable, to work around this issue, you need to:

1. Remove the CEEOPTS statement. The EXEC PARM field can be changed to
PARM="TRAP(OFF,NOSPIE)/", if required
2. Move the CEEOPTS member to a world-readable library.

MFIO

Back to the list

« Enterprise Developer now includes the SourceConnect functionality.
2807623 (1098289)

Micro Focus Common Client
Back to the list

« COBOL Web, EJB, and REST services with Japanese characters in their names can now be deployed
to Enterprise Server.

Micro Focus Directory Server
Back to the list

» Fixed an issue in the Enterprise Developer Administration HTML GUI if a long user id value was input.

2846804 (1102971)

« Enterprise Server instance startup performance has been improved, particularly when the Enterprise
Server Administration GUI has been configured to use SSL.

2837359 (1101501)

» Issue fixed where the Enterprise Server Administration HTML GUI occasionally became unresponsive if
configured to use an SSL browser connection.

2834446 (1101342)

« The Enterprise Server user id no longer needs to have security administration access permissions to
start an Enterprise Server instance if external security is specified.

Monitoring and Management
Back to the list

« The Operations Manager agent no longer logs a warning event 21405 for machines being monitored
that do not have Enterprise Server installed .

2830110 (1100895)
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PL/I Support
Back to the list

* A problem when using function names without parentheses in a SELECT statement has been fixed.

2850897 (1103138)

* A memory leak in IF statements with the ANY built-in function on a CONTROLLED array has been
fixed.

2847413 (1102718)
e The -fh7asfb1l5 compile-time option is now recognized by mfplx.

2846327 (1102571)

e The maximum number of PCB parameters under the -systemims compile-time option is now a
maximum of 99.

2846066 (1102523)
« A problem with named constants of type BIT has been fixed.

2843898 (1102375)

* A non-zero scale-factor supplied to the DIVIDE built-in for FIXED BINARY arguments is now diagnosed
with an E-level diagnostic stating that an integer result will be produced. (Note: scaled fixed binary
arithmetic is not supported.)

2842326 (1102119)
« A code generator issue causing a runtime SEGV has been fixed.

2842145 (1102029)
« A problem with the -zalign option causing message MFPLIO2000A has been fixed.

2842061 (1102034)
* A problem when a named constant of type BIT is declared with VALUE (") has been fixed.

2841654 (1102010)
» A problem when using function names without parentheses in a SELECT statement has been fixed.

2841422 (1101968)
« A problem when specifying alternate currency symbols has been fixed.

2840770 (1101853)
* A problem with the -graphic option when used with mfplx and -sqgl support has been fixed.

2838680 (1101581)
* A problem with automatic initialization has been fixed.

2837702 (1101488)

» A problem with initial repetition factors not working for the GRAPHIC and WIDECHAR data types has
been fixed.

2830665 (1100640)
e A problem with the RANDOM built-in function has been fixed.

2830364 (1100611)

« Previously, when using the non-standard option -margins 1,72 and the macro preprocessor (or -Cics),
additional blank lines were infused into the source code causing the debugger line numbers to be off
and the stepping in the debugger to appear nonsensical. This no longer happens.

2835663 (1101366)

» Previously, a CICS program invoked via an EXEC CICS LINK and compiled in EBCDIC was not
generating a proper notification of the load of the shared object. This no longer occurs.

2834253 (1101339)
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Previously, if using a hex literal constant that used PL/I continuation rules for -margins 2,72, an infinite
loop would occur in the macro preprocessor. This no longer occurs.

2852567 (1103328)
When using the -incafter and -mvs macro preprocessor options compiling using mfplx, the compiler
erroneously put the %INCLUDE in column 1 before the %IGNOREMARGINS directive.

2844255 (1102268)

Previously, if debugging an application that contained two EXEC CICS statements that appeared
consecutively with no intervening blank lines, upon stepping in the debugger, the debugger would jump
to the middle of the second CICS statement before resuming execution at the proper point on the next
non-CICS statement.

2842819 (1102108)

Previously if the DAYS() built-in function was used without the optional "Pattern” parameter, a trap
occurred because the "default" pattern of 'YYYYMMDDHHMISS999' was not supplied to the underlying
routines. This has now been fixed.

2849349 (1103295)

Previously, if using the CODEWATCH notifications and a PUT EDIT triggered a file condition such as
ENDPAGE, the format chain associated with the PUT EDIT statement was not correctly processed upon
resuming after the notification. This has now been fixed.

2842068 (1102012)
A problem with concatenation of GRAPHIC strings has been fixed.

2840750 (1101850)

Previously a KEY condition was incorrectly raised if a KEY(d) read was issued against a VSAM file
which had one or more alternate indexes defined. This has now been fixed.

2838613 (1101607)

The PL/I preprocessor and DB2 pre-compiler didn't process group variables with SQL TYPE BLOB in
them properly resulting in wrong output for BLOBs. This has now been fixed.

2842781 (1102815)
A problem occurring when an illegal argument passed to the HEX built-in function has been corrected.

2833417 (1100982)

Previously, if a program specified via JCL a RECFM equal to F, FB, FBA, FBS and did not specify an
LRECL but instead depended upon the RECSIZE attribution within the ENVIRONMENT option on the
file declaration, then an UNDEFINEDFILE was incorrectly raised. This no longer occurs.

2838039 (1101528)

When using the Italian EBCDIC Codeset (0039), compiling with -ebcdic and emitting or consuming PL/I
overpunch characters (R or T) the resulting output was not correctly emitted with the X'C0' and X'D0'
characters respectively.

2836438 (1101375)

Previously, if writing to a variable length relative record dataset and the buffer used for the record was
less than the maximum record length, storage corruption could potentially occur. This no longer
happens.

An attempt to read into an automatic variable of a size smaller than that of the largest variable-length
record defined for a file sometimes caused stack corruption.

Previously, if using the DAY S() built-in function from a program executing under Enterprise Server, the
returned result was incorrect. This no longer occurs.

Previously, if two EXEC CICS statements sandwiched a multi-line comment without any whitespace or
PL/I statements containing semi-colons, an additional blank line was generated in the MDECK which
resulted in debugging lines being off by one. This no longer occurs.

Previously, if using the CICS precompiler to compile a filename where the filename's length as specified
exceeded 65 bytes, an erroneous additional %FILE statement was injected on the second macro
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preprocessor pass specifying the output file from the CICS precompiler rather than the original source.
This caused a problem for the debugger as the debug information now pointed to a non-existent
temporary file. This no longer occurs.

< Previously, if no "-margins" option was specified, the macro preprocessor wrapped at column 256. It
now wraps at column 1023.
e The TRIM built-in function is now supported as part of the PL/I Macro Language.

* Previously, if using a %REPLACE statement which contained a string with embedded pairs of single or
double quotes to signify that the string literal constant contained a double or single quote, the resulting
%REPLACE wasn't properly re-generated in the output deck. This has now been fixed.

Run-Time System
Back to the list

* Inthe JVM COBOL run time, an alphanumeric comparison with a collating sequence now gives correct
results for character values greater than 127.

2839717 (1101845)

- If afile is opened for Read with 'deny neither read nor write' and then the same file is opened for Read
(or Read/Write) with 'deny write', then when the second FD is closed, the 'deny write' file lock was NOT
removed. This has now been resolved.

2837230 (1101419)

e 64-bit Windows only, and native generated code only. Programs containing code of the form 01 f
comp-2. compute f =f** 0.5 no longer give a load error at run time (for .gnt code) or fail to link (.obj
code) with the message "unresolved external symbol _tMc4506".

2836893 (1101465)
« Under Enterprise Server, a stateful web service containing CICS code no longer hangs if a runtime
error occurs in a nested link level.

2836252 (1101438)
« When using "mfauditadm -r" on an audit file containing processes that have very long command lines,
the process could terminate early with a memory fault. This has now been resolved.

2832770 (1101000)
* The Sharedmem demo has been updated to make it compatible across all supported UNIX platforms.
Previously, on some platforms the semaphore synchronization did not work.

« Repeatedly calling and cancelling different programs in different threads could cause the application to
hang. This has now been resolved.

* Inthe .NET runtime, a managed executable can now be successfully executed using
CBL_EXEC_RUN_UNIT when an explicit .exe extension is specified in the program name.

2845604 (1102669)
e Anew library routine, PC_PRINTER_INFO_DOTNET, is now available for NET COBOL applications. It
enables the access to the .NET Graphics/PageSettings objects.

2845991 (1102545)

* .NET COBOL applications can now use PC_PRINTER_LOAD_BMP more than once without this
causing unexpected exceptions.
2845991 (1102546)

« Applications that use run units created with the MicroFocus.COBOL.RuntimeServices class could leak
memory.

2838583 (1101639)
e The XML I-O preprocessor no longer incorrectly represents some fixed point values in floating point
format.

2837561 (1101473)
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SQL: COBSQL
Back to the list

The COBSQL preprocessor has been updated to correctly handle P(CP) with the NOSQL directive.

2850394 (1103086)
Background parse should now create temporary files with names that differ from the actual build
process.

2843719 (1102613)

HCO for DB2 LUW
Back to the list

A compiler error that resulted from the DB2 ECM preprocessor incorrectly handling embedded
comments within an SQL statement has been fixed.

2846756 (1102646)
An HCO pre-compiler routine incorrectly replaced an underscore in host variable name which resulted
in invalid host variable. This has now been fixed.

2837674 (1101487)

SQL: HCO for SQL Server
Back to the list

HCO for SQL Server now supports optimization of DB2 SQL statements by adding SQL Server query
hints, such as OPTION(RECOMPILE), to select, insert, update, and delete statements.

2837973 (1101513)
In certain scenarios, OpenESQL incorrectly handled nested subselects.

2837591 (1101469)
A new SQL compiler directive option, SPCALLLOCAL, is available to transform EXEC SQL CALLs that
invoke stored procedures into COBOL calls that invoke local COBOL subroutines.

2836255 (1101304)

The SQL(SPCALLLOCAL) compiler directive is now available for use with HCO for SQL Server to
enable simulation of DB2 stored procedure execution and the return of result set locators to the caller.
This can improve performance for some applications and deployment scenarios over the alternative of
deploying DB2 stored procedures as SQL CLR stored procedures.

2835095 (1101181)
HCO for SQL Server incorrectly converted queries using multiple FETCH FIRST clauses in nested
subselects.

2834305 (1101119)

The OpenESQL run-time was updated to correctly locate the HCO for SQL Server SQLCode mapping
file under the Visual COBOL/Enterprise Developer products for VS2012.

2832258 (1100963)

A problem with SQL(CHECK) producing false errors has been fixed when using SQL Server 2012 or
later versions.

2850575 (1103116)

A problem with HCOSS transformations for IN expressions that use row constructors to TSQL EXISTS
has been fixed.

2844923 (1102580)
An issue where HCOSS did not correctly recognize some OUTER JOIN clauses has been fixed.
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2841819 (1102007)

SQL: OpenESQL
Back to the list
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An overflow problem with host variables of type System.Decimal has been fixed.

2849939 (1103195)

OpenESQL has been updated to correctly handle cursors in static methods when using DBMAN=ODBC
in a managed application.

2847268 (1102968)
A problem with EXEC ADO REBIND CONNECTION has been fixed.

2846426 (1102645)
In some scenarios, OpenESQL for ADO.NET incorrectly handled level 49 VARCHAR host variables
defined with zero (0) length.

2845409 (1102510)

HCOSS with SQL(CHECKCALLPARAMS) now correctly determines parameter types and directions for
SQL, SQL synonym, and SQL CLR stored procedure calls that use four-part names, and that are
located on other servers or in other databases.

2844292 (1102483)
HCOSS did not fully support DB2 ROW_NUMBER().

2843937 (1102362)
Using SQL(CHECK) with .NET applications caused an error on Oracle.

2842102 (1102037)

The OpenESQL JVM Runtime was updated to correctly process a FETCH from a VARCHAR column
where the field is zero length.

2841149 (1102637)

The Project Properties user interface has been updated to include SYBASE and INFORMIX-NEW on
the COBSQLTYPE options list.

2840953 (1101877)

An EXEC ADO GET DATATABLE statement for DataTables contained within a dataset resulted in SQL
errors.

2837717 (1101484)

HCO for SQL Server incorrectly returned result set locators for result sets containing VARCHAR(MAX)
columns.

2832384 (1101169)

The ADO and JDBC runtimes have been updated to fix a share lock problem that occurred when
SQL(ISOLATION) was set.

2797208 (1096456)

To correct a problem when using SQL(DETECTDATE) with SQL Server datetime columns, applications
updating to Visual COBOL 2.3 might require use of the SQL(DETECTDATE) directive if they use SQL
Server datetime columns with PIC X host variables. Alternative solutions are to switch to datetime2, or
to use SQL TYPE TIMESTAMP host variables.

2850022 (1103058)

To correct a problem with closing CURSORSs, SQL(SPCALLLOCAL) can now be used to instruct
OpenESQL to detect and close cursors associated with simulated stored procedures not closed by an
application.

2848402 (1102838)



When using SQL Server version 2012 SP2 or later, OpenESQL now supports a [NOCHECK] statement

prefix to enable SQL(CHECK) to be disabled on a per-statement basis. If used with other statement
prefixes, it must come first. When compiling programs that use global temporary tables, HCOSS
executes converted DECLARE GLOBAL TEMPORARY statements at compile time. These enable
subsequent statements that reference the temporary table to be checked using SQL(CHECK).

2847791 (1102782)

OpenESQL now supports SQL(DETECTDATE=SERVER) when using the ADO.NET runtime and SQL
Server version 2012 or later. SQL(DETECTDATE=SERVER) is ignored when using ADO.NET with
earlier versions of SQL Server, and when using any other database.

2846825 (1102701)

When migrating a DB2 application using HCOSS, a compiler error caused by string concatenations that

included literals containing angle bracket characters has been corrected.

2846226 (1102582)

A new directive, CHECKSP, has been added to the OpenESQL preprocessor to verify whether or not
parameters match the COBOL definitions defined in a stored procedure. If not, the OpenESQL
preprocessor generates error ES0127. The syntax is: SQL(CHECKSP=<spd-filename> CHECKSP
applies only when SQL(SPCALLLOCAL) is also used.

2844399 (1102329)

The POSTGRESQL parameter for the TARGETDB SQL compiler directive option was erroneously
omitted from the drop-down list in the user interface.

2842879 (1102128)
When using the OpenESQL JDBC Managed Runtime with positioned updates on a cursor, an error
occurred when the same cursor was opened and closed multiple times.

2841857 (1102003)
The OpenESQL runtime for ADO.NET was erroneously trimming trailing spaces from variable-length
input host variables that used an explicit-length field.

2841721 (1102106)
A problem with disconnecting named connections when using the JDBC runtime for OpenESQL has
been fixed.

2841508 (616495)

When compiling applications with SQL(DIALECT=MAINFRAME), literals could be corrupted with
embedded spaces.

2839826 (1101752)

In European locales, Oracle queries failed to return the decimal symbol for floating point results
returned to decimal numeric host variables.

2839066 (1102162)
OpenESQL SAVEPOINT handling was not working as expected with Static SQL.

2838227 (1101571)

An HCOSS stored procedure called from multiple locations in either the calling application or in a
nested stored procedure, and that returns result set locators, resulted in an SQLCODE error.

2834386 (1101104)
HCO for SQL Server returned incorrect output parameter values when a CALL statement specified a
stored procedure name in a host variable.

2833755 (1101022)

OpenESQL with DATE+EUR erroneously returned values representing a 12-hour clock. Returned
values now correctly represent a 24-hour clock.

2833683 (1101017)

Resolved Issues
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The SPD Generator did not set the NOTRUNC directive when generating a SQL CLR wrapper.

2829499 (1102075)

When running in ODBC mode, the OpenESQL Assistant DCLGEN sometimes generated incorrect
TIMESTAMP and DATE column sizes. It now generates the TIMESTAMP(6) columns as PIC X(26) and
the DATE columns either as PIC X(19) or X(10) based on the NLS_DATE_FORMAT setting.

2823577 (1099922)

The documentation has been updated to clarify the issue of trailing spaces in comparisons for PIC X
host variables with CHAR and VARCHAR columns.

2806980 (1097582)

An attempt to compile in Visual COBOL with OpenESQL using unsupported HCOSS directives now
returns errors rather than warnings. HCOSS is not supported in Visual COBOL.

OpenESQL for ADO.NET did not recognize and handle Oracle's full managed .NET provider in addition
to the original partially managed provider. Note: The two providers are not 100% compatible. The
partially managed provider uses NLS settings for date/time formatting and the fully managed provider
uses the local machine locale.

SQL Option for DB2
Back to the list
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The XDB pre-processor incorrectly processed SQL statement that had embedded singles within a
literal. This resulted in receiving an incorrect message "cobsqlO111le - no from clause specified error".

2850293 (1103073)

When using an open cursor with constants comparison in an IN () clause, an Sglcode -1352 error
occurred.

2844111 (1102266)

An SQL statement with SELECT caused an XDB with Server Violation error when converting from the
CHARACTER to INTEGER type in the INSERT SQL statement.

2839382 (1101677)

Incorrect results sometimes occurred when using a host variable for the second parameter of the SQL
scalar function ROUND() function.

2831359 (1101083)
Exiting SQLWizard processing no longer causes an exception.

2849696 (1103097)

A problem with the display of code page conversions in the SQLWizard Import/Export dialog boxes has
been resolved.

2846196 (1102659)
An issue that resulted in a syntax error when editing tables with decimal data has been resolved.

2840937 (1101960)

Exporting a table with a reserved word as a column name no longer produces an error X020 if the
quoting types are Apost or Quote.

2806803 (1097559)
An RTS 114 error would sometimes occur on an UPDATE WHERE CURRENT OF CURSOR.

2840936 (1101868)

When executing a batch job containing XDB Null loads, an error occurred during DSNUTILB processing
when loading the XICU40N DLL.

2840147 (1101785)



« An execution error resulted when using dynamic SQL with an SQLDA SQLN integer much larger than
required for input parameter markers.

2818992 (1099256)

XML Support
Back to the list
« PREXML now terminates and returns an error message if there is a problem expanding a copybook.

2472213 (1076394)
« XMLPARSE did not honor the encoding in the XML declaration for output text.

2851343 (1103239)

* XML WRITE with CHECK VALIDITY OUTPUT no longer causes RTS 114 error if the written document
contains an XML declaration.

2837110 (1101424)
e XMLPARSE did not handle CONTENT-CHARACTERS correctly in XMLSS mode.

2822339 (1099692)
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Other Issues Resolved In This Release

The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
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2266906 (1066314)
2541594 (1081441)
2610077 (1087571)
2613606 (1088533)
2691674 (1093498)
2784725 (1095083)
2792882 (1102055)
2801626 (1097006)
2801847 (1097374)
2805056 (1097357)
2806566 (1097816)
2807649 (1097763)
2809132 (1097892)
2812331 (1098359)
2815582 (1099634)
2817630 (1101066)
2824712 (1100086)
2824925 (1099961)
2825098 (1100032)
2825249 (1101374)
2827707 (1100302)
2828305 (1100419)
2828897 (1100491)
2829677 (1100588)
2830741 (1100655)
2830871 (1100785)
2831477 (1100831)
2831788 (1100810)
2831959 (1100864)
2832490 (1100907)
2832904 (1100916)
2833083 (1101060)
2833100 (1101123)

Other Issues Resolved in This Release

2833473 (1101007)
2833925 (1101045)
2834217 (1101124)
2834245 (1101085)
2834253 (1101099)
2834843 (1101156)
2834959 (1101167)
2835289 (1101498)
2835416 (1101496)
2835506 (1101288)
2835508 (1101292)
2835599 (1101293)
2835608 (1101494)
2835687 (1101497)
2835835 (1101262)
2836694 (1101356)
2837531 (1101490)
2837784 (1101511)
2838086 (1101525)
2838343 (1101586)
2838426 (1101552)
2838593 (1101986)
2838671 (1101587)
2838689 (1102052)
2839730 (1101776)
2840155 (1101821)
2840349 (1101906)
2840530 (1101860)
2840658 (1101893)
2840766 (1101857)
2840977 (1102019)
2841607 (1101961)
2841785 (1101988)

2841933 (1102021)
2842318 (1102129)
2842702 (1102121)
2842940 (1102122)
2843048 (1102186)
2843076 (1102135)
2843140 (1102509)
2843301 (1102185)
2843324 (1102296)
2843438 (1102240)
2843446 (1102173)
2843446 (1102174)
2843884 (1102492)
2845184 (1102627)
2845218 (1102490)
2845635 (1102601)
2845781 (1102730)
2846150 (1102557)
2846669 (1102644)
2846797 (1102780)
2846971 (1103070)
2847253 (1102806)
2847876 (1102765)
2848324 (1103143)
2849271 (1103044)
2849307 (1102974)
2849430 (1103011)
2849508 (1102970)
2849972 (1103094)
2851114 (1103175)
2851169 (1103174)
2852143 (1103362)



Installation

Before Installing

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows

System Requirements

Hardware Requirements

The disk space requirements are approximately:

Enterprise Server Sentinel RMS License Manager

1.2Gb 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note: This product can be installed on earlier versions of Windows but it has not been tested on
them.

Software Requirements

f Note:

» The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
e This product includes OpenSSL version 1.0.1p.

Before installing this product, you must have the following software installed on your computer:

e The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:

* Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.
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Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.

f Note:

.NET Framework 3 is provided with Windows Vista and Windows Server 2008.
e .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
e .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
e .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
* .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.

Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

A Web browser is required for Enterprise Server Administration in Enterprise Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).

To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems. Also, active
content must be allowed and not blocked. To enable both these in Internet Explorer:

1. Click Tools > Internet Options.

2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click
Enable.

3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active
content to run in files on My Computer is checked.

Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable
the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus License

—' Administration tool. For local servers, you do not need to install it separately, as the setup file installs

a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements

To ensure full functionality for some Enterprise Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Server setup file.

Click here to see this information on the Micro Focus Infocenter.

Installation Restrictions and Requirements

Before starting the installation, you should consider the following:

You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.


http://www.microfocus.com/docs/links.asp?nx=WPI20
http://supportline.microfocus.com
http://documentation.microfocus.com/help/topic/com.microfocus.eclipse.infocenter.enterpriseserver.win/GUID-3280F74E-1512-414A-8E56-0F6CBB2F72F8.html

» Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an Enterprise Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Product Co-Existence
f Note: The following applies to Windows only.

« Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.
« Enterprise Server and Enterprise Test Server cannot coexist on the same machine.

On UNIX

System Requirements

Hardware Requirements

The disk space requirements are approximately:

Installation
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Platform Installer type Setup Disk space Disk space Sentinel RMS
file size required for required for license
(MB) the installation running server
(GB) the product (11
(MB)
POWER Micro Focus installer 479 1.91GB 958 36.5
running AlX
HP 1A Micro Focus installer 782 3.13GB 1564 69
System Z Micro Focus installer 324 1.29GB 648 36
running Red
Hat Linux
x86-64 Micro Focus installer 338 1.35GB 676 46
running Red
Hat Linux
SPARC Micro Focus installer 386 1.54GB 772 40
running
Solaris
x86-64 Micro Focus installer 351 1.40 GB 702 31
running
Solaris
System Z Micro Focus installer 328 1.31GB 656 36
running SUSE
SLES
x86-64 Micro Focus installer 344 1.38GB 688 46
running SUSE
SLES

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

i Note: This product includes OpenSSL version 1.0.1p.

Before installing this product, you must have the following software installed on your computer:

» The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

« On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:

glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686
e On IBM System z (390), you must have the following operating system libraries installed:

glibc-*.s390
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glibc-*.s390x
libgce-*.s390
libgcc-*.s390x

Visit the Red Hat Web site for more information.
e On SUSE and Red Hat, PL/I support requires that you have the following operating system libraries
installed:

libelf-devel-0.137-8.19
libelf1-0.137-8.19
libelf1-32bit-0.137-8.19

e Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required for native COBOL and Java
interoperability. The setup file installs Java 8 u51 32-bit. You can download Oracle's Java EE from
Oracle's Web site and install it anywhere on your machine.

f Note:

e On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

« On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

* You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

» The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

set classpath=j dk-install-directory\lib\tools. jar

« JavaScript or scripting support must be enabled in your browser, so that Enterprise Server

Administration is usable. Also, active content must be allowed and not blocked.

v+, Important: This release requires version 10000.2.990 or later of the Micro Focus License
== Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool .sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX

To ensure full functionality for some Enterprise Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Server setup file.

Click here to see this information on the Micro Focus Infocenter.
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UNIX and Linux Installer Issues

License Server
You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.| ocal domai n localhost
I P machi nel onghost name machi neshort host name

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation

Installation

The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks.

Installing on Windows

Note: If there is an earlier version of Enterprise Server installed on your machine, check Installing as
an Upgrade first.

These are the steps to install this product:

1. Runthe es_231.exe file and follow the wizard instructions to install the prerequisite software and the
product.

The setup file will also install any missing prerequisite software as listed in Software Requirements.

i Note:

If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

« Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

* We recommend that you install any updates for the .NET Framework that are available at the
Microsoft Download site.

» If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Server but you can install it if you wish.


http://www.microfocus.com/DOCS/LINKS.ASP?NX=CTL1

Installing on UNIX

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:
chmod +x setup_ent_server_2.3 updatel platform
2. Run the installer with superuser permissions:
./setup_ent_server_2.3 updatel pl atform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL run-time is installed by default into Zopt/microfocus/EnterpriseDeveloper,
(COBDIR).

f Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

SafeNet Sentinel considerations

« The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the —-skipsafenet option, which skips the
installation of SafeNet:

-/setup_ent_server_2.3 updatel pl at f orm -skipsafenet

» To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET _INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Advanced Installation Tasks (Windows)

This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

« Installing as an Upgrade

Installation
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Command line installation options

To see this information on the Micro Focus Infocenter, click here.

Installing as an Upgrade

Before installing, check Installation Restrictions and Requirements.

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Server Installation Options

To install Enterprise Server you run es_231 .exe which contains a number of product .msi files (Windows
Installer packages). When run, es_231.exe performs some initial system checks then sequentially installs
the .msi files.

es_231_exe can take a number of parameters, enabling you to specify a number of different types of
installation:

Standard Installation

Format:
es_231.exe
Summary:

Full installation including License Manager and Enterprise Server. During installation you can specify
options including the location to which the components are installed.

Non-interactive Installation

Format:

es_231._exe /passive

Summary:

Full installation, but the components are installed non-interactively using default options and
directories.

Silent Installation

Format:
es 231.exe /q
Summary:

Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

Modified Silent Installation

Format:
es 231.exe /q InstallFolder=d:\cobolrts
Summary:

Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Server is installed to dz\cobolrts.

To see what parameters you can use, execute the following from the command line: es_231.exe /2.

y Note:


http://documentation.microfocus.com/help/topic/com.microfocus.eclipse.infocenter.enterpriseserver.win/GUID-C557E6C9-4179-44B8-B999-4D97759CEB6E.html

* Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log. txt. This creates a log file, named log. txt, in the d:\temp directory.

Advanced Installation Tasks (UNIX)

This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

« Installing as an Upgrade - included in these Release Notes

« Command line installation options - included in these Release Notes

« Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus
Infocenter

Click here to see this information on the Micro Focus Infocenter.

Installing as an Upgrade

This release works concurrently with the previous version of Enterprise Server, so you do not need to
uninstall it. There are two options for installing the latest version in this case:

* Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/
EnterpriseDeveloper, by default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/EnterpriseDeveloper /opt/microfocus/
EnterpriseDeveloperver si on

2. Install the latest version as described in the section Installing.
« Install the latest version in a different location and set the environment to point to it. To do this, run the
Enterprise Server installer with the —installlocation option:

1. Execute the following command:
- /installFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

i Note: You can use variables or the tilde syntax for the path for —instal I location. For
example, the following examples are equivalent:

-installlocation="/home/myid/i nstal | di r "
-installlocation="~myid/i nstal I di r"
-installlocation="~/instal l dir"

—-installlocation="$HOME/i nstal | di r "
2. Execute cobsetenv to set the environment and point to the new install location:
. /opt/microfocus/EnterpriseDeveloper/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.
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Installing into a different location

To install in a different location use the —instal I location=""Location' parameter to specify an
alternative directory location. For example:
./ -installlocation="full path of new | ocation"

y Note: You can use variables or the tilde syntax for the path for —instal I location. For example,
the following examples are equivalent:
-installlocation="/home/myid/i nstal [ di r"

—-installlocation="~myid/i nstal | dir"
—-installlocation="~/instal I dir"
—-installlocation=""$HOME/i nstal | di r "

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="l ocation"™ ] [ -ESadminID="User ID" ] [ -CASrtDir="l ocation" ], where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsyslLog=""/home/esuser/l1ogs". The default location is /var/mfcobol/

logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, ~-ESadminID=""esadm". The default user ID is the one that runs the installer.

-CASrtDir  Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.f

You can use the following command line arguments to install silently on UNIX/Linux:

—silent -lacceptEULA

For example, execute:
[as root] setup filenane —silent -lacceptEULA

After Installing

Installation

« See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.

e Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.
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On Windows

To access the Enterprise Server help:

« On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus Enterprise Server
> Documentation from the Windows Taskbar.

* On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the Enterprise Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Enterprise >
Micro Focus Enterprise Server.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

v+, Important: The installer creates separate installations for Micro Focus Enterprise Server and Micro
~*' Focus License Administration. Uninstalling only Enterprise Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /Zuninstall

On UNIX

Setting the Environment
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv
2. To verify that your product is installed, execute:

cob -V

Installation
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/v, Important: These commands set the environment only for the current shell. You need to execute
=*' them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.
Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.
Uninstalling

Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseServer2.3.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the Unlnstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.



Licensing Information
i Note:

» If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

« Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8, Windows 10, and Windows Server 2012, you use the Start screen to invoke
programs.

Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool .sh

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
Click the Install tab.
3. Do one of the following:

n

» Click Browse next to the License file field and select the license file (which has an extension
of _.mflic).
* Drag and drop the license file from Windows Explorer to the License file field.
* Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.
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If you have an authorization code

Authorizing your product when you have an Internet connection

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Start Micro Focus License Administration.

Click the Install tab.

Type the authorization code in the Enter authorization code field.
4. Click Authorize.

w N e

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

Start Micro Focus License Administration.

Click Manual Authorization on the Install page.

Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:

pwWwDdDPRE

< If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

< If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.

Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

Type the Machine ID in the Machine ID field.
Type your email address in the Email Address field.
Click Generate.

Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.

10.Click Install Licenses.

o

© x® N

In order to authorize your product you must have the following:

* Your authorization code (a 16-character alphanumeric string).

Licensing Information



e The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

Click Generate.

Copy the licenses strings from the web page or the email you receive into a file.

Put the license file onto your target machine.

Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.

7. Enter the name and location of the license file.

o0 s w

To obtain more licenses

If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

« The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

« The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

* The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

i Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

e The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

e The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusintl.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

« The name and version number of all products that you think might be causing a problem.

e Your computer make and model.

* Your operating system version number and details of any networking software you are using.

* The amount of memory in your computer.

* The relevant page reference or section in the documentation.

* Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( -dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportinfo, to create
either:

« a . logfile that contains the details about your environment, Micro Focus SupportLine products, and
settings.

e a .zip archive that includes the same information as the . log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportinfo.exe is stored in <i nstal | - di r >\bin.
To run MFSupportinfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a . log file or a .zip archive as follows:

a. To create a . log file, click File > Save.

This prompts to save the . log file, MFSupportinfo_Log Machi neNane_YYYY-MM-DD_ HH-MW-
SS. l1og, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportinfo_Log Machi neNane_YYYY-MW-DD HH-MW-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either

the . log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mFsupport, to create a log file that
contains the details about your environment, product, and settings. The mFsupport script is stored in
$COBDIR/bin.

To run mFsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mFsupport from a directory where you have write permissions.

This creates a log file, mfpol I . txt, in that directory.
4. When the script finishes, send the mfpol I . txt file to your Micro Focus SupportLine representative.

f Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of Zopt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer

This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fithess for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.
Copyright © Micro Focus 1984-2016. All rights reserved.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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